
RISAFoundation 

Rapid Interactive Structural Analysis ï Foundations 

Version 3.0 - General Reference 

  

  

  

  

  

  

  

  

  

  

  

  

 

26632 Towne Centre Drive, Suite 210 

Foothill Ranch, California 92610 

  

(949) 951-5815 

(949) 951-5848 (FAX) 

www.risatech.com 

http://www.risatech.com/


  

  

Copyright 2010 by RISA Technologies, LLC All rights reserved. No portion of the contents of this 

publication may be reproduced or transmitted in any means without the express written permission of 

RISA Technologies, LLC. 

  

  

We have done our best to insure that the material found in this publication is both useful and accurate. 

However, please be aware that errors may exist in this publication, and that RISA Technologies, LLC 

makes no guarantees concerning accuracy of the information found here or in the use to which it may be 

put.  



Table of Contents 

General Reference Manual I 

Table of Contents  

Before You Begin ............................................... 1 

Overview ........................................................... 1 

Hardware Requirements .................................. 1 

Program Limits ................................................. 2 

License Agreement .......................................... 2 

Maintenance ..................................................... 3 

Installation ........................................................ 3 

Application Interface ......................................... 5 

Main Menu ........................................................ 5 

Shortcut Menu .................................................. 8 

Toolbars ............................................................ 8 

Dynamic View Controls .................................... 11 

Shortcut Keys and Hot Keys ............................ 12 

Status Bar ......................................................... 13 

Windows ........................................................... 14 

Modes ............................................................... 14 

Beams ................................................................. 16 

Drawing Beams ................................................ 16 

Modifying Beam Properties .............................. 17 

Beams Spreadsheet ......................................... 18 

Physical Members ............................................ 19 

Customizing RISAFoundation .......................... 20 

Save as Defaults .............................................. 20 

Preferences ...................................................... 20 

Design Optimization .......................................... 25 

Design Rules - General .................................... 25 

Design Rules - Beam Rebar ............................. 25 

Design Rules - Slab Rebar ............................... 26 

Design Rules - Footing/Pile Cap Rebar ........... 27 

Design Rules - Pedestal Rebar ........................ 27 

DXF Files ............................................................ 28 

Exporting Foundation Plan Drawings ............... 28 

Exporting Footing Details ................................. 29 

Exporting Slab Reinforcing Details ................... 29 

DXF Element Numbers .................................... 29 

DXF File Format ............................................... 30 

File Operations ................................................... 32 

Starting Off........................................................ 32 

Automatic Backup ............................................. 32 

Footings - Design............................................... 34 

Footing General Properties .............................. 34 

Footing Geometry ............................................. 34 

Footing Pedestal ............................................... 35 

Soil Properties .................................................. 35 

Local Axes ........................................................ 36 

Limitations ......................................................... 37 

Footings - Combined ......................................... 38 

Strap Footings .................................................. 38 

Using Slab Foundations to Model Combined 
Foundations ...................................................... 38 

Footing Results .................................................. 40 

Solution Methodology ....................................... 40 

Sketch and Details ............................................ 40 

Soil Bearing Results ......................................... 41 

Footing Flexure Design .................................... 42 

Footing Shear Check ........................................ 43 

Pedestal Design ............................................... 44 

Stability Results ................................................ 45 

Concrete Bearing Check .................................. 46 

Footing Stability and OT Calculations ............. 47 

Calculation of OTM Stability Ratio .................... 47 

Calculation of Moment and Shear Demand for 
Unstable Footings ............................................. 48 

Limitation on Optimization for Net Uplift ........... 49 

Generation .......................................................... 50 

Circular Slab Generator .................................... 50 

Global Parameters ............................................. 51 

Description ........................................................ 51 

Solution ............................................................. 52 

Design ............................................................... 53 



Table of Contents 

II  RISAFoundation v3.0 

Graphic Display ................................................. 54 

Multiple Windows.............................................. 54 

Controlling the Model View ............................... 54 

Depth Effect ...................................................... 57 

Viewing Part of the Model ................................ 57 

Saving and Retrieving Model Views ................. 57 

Graphic Display - Plot Options ......................... 58 

Points/Footings ................................................. 58 

Beams/Pedestals/Piles/Pile Caps .................... 59 

Slabs ................................................................. 60 

Loads ................................................................ 61 

Deflection .......................................................... 63 

Design Strips/Cuts/Soil Regions ...................... 63 

Miscellaneous ................................................... 64 

Graphic Editing .................................................. 66 

Drawing and Modification Features .................. 66 

Undo Operations .............................................. 67 

Redo Operations .............................................. 67 

Project Grid ....................................................... 67 

Drawing Grid ..................................................... 69 

Snap Points ...................................................... 72 

Merging Model Elements .................................. 72 

Deleting Elements ............................................ 73 

Graphic Selection .............................................. 75 

Selection Modes ............................................... 75 

Inverting Selections .......................................... 76 

Criteria Selections ............................................ 76 

Locking Selections ........................................... 80 

Saving Selections ............................................. 81 

Help Options ...................................................... 82 

Electronic Help File .......................................... 82 

Context Sensitive Help ..................................... 82 

RISA Technologies Online ............................... 82 

Tool-tips ............................................................ 82 

Tutorial .............................................................. 82 

Loads .................................................................. 83 

Self Weight (Gravity Load) ............................... 83 

Load Categories ............................................... 83 

Copying Load Categories ................................. 84 

Deleting Load Categories ................................. 84 

Modifying Loads ............................................... 85 

Deleting Loads .................................................. 85 

Loads - Load Types ........................................... 86 

Area Loads ....................................................... 86 

Line Loads ........................................................ 87 

Point Loads and Moments ................................ 88 

Loads - Load Combinations ............................. 91 

Load Combinations Spreadsheet ..................... 91 

RISAFoundation Design Combinations ............ 92 

Generating Building Code Combinations ......... 92 

Material Properties............................................. 96 

Material Properties Spreadsheet ...................... 96 

Modeling Tips - Foundations ............................ 97 

OT Moment Stability Checks for Slabs ............. 97 

Soils Springs for Eccentric Footings ................. 97 

Modeling Complex Slabs .................................. 98 

Modeling Wall Footings .................................... 98 

Model Merge ..................................................... 98 

Pedestals ............................................................ 99 

Draw Pedestals ................................................ 99 

Modify Pedestals .............................................. 99 

Pedestals Spreadsheet .................................... 101 

Pedestals - Design & Punching Shr Checks ... 103 

Pedestal Design Values ................................... 103 

Punching Shear Values .................................... 103 

Punching Shear Geometries ............................ 104 

Pedestal Detail Report ...................................... 105 

Limitations ......................................................... 107 

Piles and Pile Caps ............................................ 109 

Defining Singular Piles ..................................... 109 

Defining Pile Caps ............................................ 110 

Pile and Pile Cap Modeling Considerations ..... 113 

Pile Caps - Design.............................................. 117 

Pile Results ......................................................... 125 



Table of Contents 

General Reference Manual III  

Pile Design Checks .......................................... 125 

Punching Shear Values .................................... 126 

Punching Shear Geometries ............................ 126 

Pile Cap Results ................................................. 128 

Pile Cap Results Browser ................................. 128 

Detail Report Information ................................. 130 

Points .................................................................. 136 

Point Coordinates Spreadsheet ....................... 136 

Point Information Dialog ................................... 136 

Points - Results .................................................. 138 

Point Deflections Results ................................. 138 

Point Reaction Results ..................................... 138 

Printing ............................................................... 139 

Printing Reports ................................................ 140 

Printing to a File................................................ 140 

Graphics Printing .............................................. 141 

Results ................................................................ 143 

Saving Results.................................................. 143 

Results Spreadsheets ...................................... 143 

Excluding Results ............................................. 144 

Graphic Results ................................................ 144 

Clearing Results ............................................... 144 

Beam Detail Reports ........................................ 144 

RISAFoundation Interaction ............................. 145 

RISAFoundation Interaction with RISA-3D ...... 145 

RISAFoundation Interaction with RISAFloor .... 147 

Limitations ........................................................ 147 

Slabs ................................................................... 149 

Drawing a Slab ................................................. 149 

Slabs Spreadsheet ........................................... 149 

Automatic Slab Meshing ................................... 150 

Slabs - Design Cuts ........................................... 152 

How to Create Design Cuts .............................. 152 

Design Cuts Spreadsheet ................................ 152 

Design Cut Results Spreadsheet ..................... 153 

Design Cut Detail Report .................................. 153 

Slabs - Design Strips ......................................... 155 

How to Create Design Strips ............................ 155 

Setting the Width of Design Strips .................... 156 

How to Modify Design Strips ............................ 157 

Design Strips Spreadsheet ............................... 157 

Design Strip Results ......................................... 158 

Design Strip Detail Report ................................ 158 

Slabs - Results ................................................... 161 

Plate Force Results .......................................... 161 

Plate Corner Force Results .............................. 162 

Soils .................................................................... 163 

Assigning Soil Properties .................................. 163 

Soil Regions Spreadsheet ................................ 163 

Soil Springs Calculation (Automatic) ................ 164 

Soil Pressure Results ....................................... 166 

Solution ............................................................... 168 

Solution Method ................................................ 168 

Spreadsheet Operations ................................... 169 

Moving and Scrolling ........................................ 169 

Spreadsheet Keyboard Commands ................. 169 

Selecting Spreadsheet Cells ............................ 170 

Undoing Operations .......................................... 170 

Redoing Operations .......................................... 170 

Editing Spreadsheets ....................................... 170 

Moving and Copying Cell Contents .................. 172 

Sorting and Finding in Spreadsheets ............... 173 

Default Spreadsheet Data ................................ 173 

Special Spreadsheet Functions ........................ 173 

Supports ............................................................. 174 

Creating and Modifying ..................................... 174 

All Support Types Spreadsheet ........................ 175 

Support Options ................................................ 176 

Units .................................................................... 178 

Standard Imperial Units .................................... 178 

Standard Metric Units ....................................... 178 

Units Specifications .......................................... 179 

Warning Log ....................................................... 180 

Technical Support.............................................. 181





Table of Contents 

General Reference Manual I 

 

 





Before You Begin 

General Reference Manual 1 

Before You Begin  

Welcome to the RISAFoundation General Reference manual. Please read this topic prior to installing the program and pay 

particular attention to the License Agreement. If you agree to the terms of the license then read the Installation section and 

install the program. If you are a first time user of RISAFoundation you should turn your attention to the User's Guide (a 

separate document) which is designed to get you up and running as fast as possible while still exposing you to the important 

features of the software. 

The User's Guide is designed to be read in two ways. If you are already familiar with structural modeling in general you can 

skip the supporting text and read only the underlined action items to quickly move through the tutorial. If you want more 

thorough explanations of the modeling process you may read all or some of the supporting text as you see fit. 

After you have gone through the User's Guide, use this General Reference for detailed information on any topic. The topics 

are arranged in alphabetical order and are thoroughly indexed. 

Overview 

RISAFoundation is a foundation analysis and design program. It has been developed to make the definition, solution and 

modification of foundation models as fast and easy as possible. Analysis, up to and including calculation of maximum 

deflections and stresses, may be done on mat slabs, spread footings, and grade beams. Complete reinforcing detailing is also 

included in the program. 

RISAFoundation has full graphical modeling capability. You can draw your model on the screen and also perform extensive 

graphical editing simultaneously in multiple views. To modify your model data directly, RISAFoundation employs a 

powerful, proprietary spreadsheet. All this combined with flexible data generation algorithms makes modeling very easy. 

Graphic display of the model along with applied loads, boundary conditions and much more, is always available. The model 

can be rapidly edited, solved, viewed, modified, re-solved, etc. The truly interactive nature and design output of 

RISAFoundation is its primary strength. 

You may access the features in RISAFoundation by using the menu system, or the toolbars. The best way to learn 

RISAFoundation is to go through the User's Guide. The advantage to this is that you are exposed to the tools 

RISAFoundation provides AND the ways that you can take advantage of them. 

Hardware Requirements 

Minimum 

¶ Any Windows compatible computer with a Pentium 3 or better processor 

¶ Windows 2000\XP\Vista\Windows 7 

¶ 256 MB of RAM 

¶ 200 MB of hard disk space 

¶ Two or three button mouse 

¶ USB port (required for Stand-Alone version or the Network Host computer) 

Recommended 

¶ Windows XP\Vista\Windows 7 

¶ As much extended RAM as possible 

¶ As much free disk space as possible 

¶ Two button mouse with wheel 

Note 
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¶ The amount of space needed by RISAFoundation  to solve a particular structural model depends on the size of the 

model. RISAFoundation  has been written such that it will use as much RAM as is available. If this isn't enough, 

RISAFoundationn will start using HD space until enough memory is obtained to solve the problem. Of course, if 

RISAFoundation is required to use HD space, the solution will be much slower. So, the more memory you have 

available, the better. In general, 500 Megabytes (MB) of RAM is a good amount to solve most problems. 

However, if you will be regularly solving large problems, more memory will save you a lot of time in the long 

run. 

Program Limits 

32,000 Points 

32,000 Beams 

32,000 Plates 

500 Materials 

2,000 Point Loads 

2,000 Line Loads 

200 Area Loads 

1,000 Load Combinations 

100 Slabs 

100 Soil Regions 

1,000 Supports/Footings 

100 Design Strips 

Demonstration Version: While you can open and solve a larger model, the largest model that can be saved to disk with the 

demonstration version is limited to 10 Supports/Footings, 5 Beams, and 1 Soil Region. 

License Agreement 

END-USER LICENSE AGREEMENT FOR RISA Technologies, LLC® SOFTWARE 

The RISAFoundation software product (SOFTWARE PRODUCT) includes computer software, the associated media, any 

printed materials, and any electronic documentation. By installing, copying or otherwise using the SOFTWARE PRODUCT, 

you agree to be bound by the terms of this agreement. If you do not agree with the terms of this agreement RISA 

Technologies, LLC is unwilling to license the SOFTWARE PRODUCT to you. In such event you must delete any 

installations and destroy any copies of the SOFTWARE PRODUCT and return the SOFTWARE PRODUCT to RISA 

Technologies, LLC within 60 days of purchase for a full refund. 

Copyright 2010 by RISA Technologies, LLC. All rights reserved. The SOFTWARE PRODUCT is protected by United 

States copyright laws and various international treaties. All rights not specifically granted under this agreement are reserved 

by RISA TECHNOLOGIES. 

1. SOFTWARE LICENSE. The SOFTWARE PRODUCT is licensed, not sold. All right, title and interest is and remains 

vested in RISA Technologies, LLC.  You may not rent, lease, or lend the SOFTWARE PRODUCT. You are specifically 

granted a license to the use of this program on no more than one CPU at any given time. The Network Version of the 

SOFTWARE PRODUCT is licensed for simultaneous use on a certain maximum number of network stations that varies on a 

per license basis. As part of the license to use the SOFTWARE PRODUCT, the program user acknowledges the reading, 

understanding and acceptance of all terms of this agreement.  The SOFTWARE PRODUCT may not be reviewed, compared 

or evaluated in any manner in any publication without expressed written consent of RISA Technologies, LLC. You may not 

disassemble, decompile, reverse engineer or modify in any way the SOFTWARE PRODUCT. If the SOFTWARE 

PRODUCT was purchased at a discounted price for educational purposes it may in no event be used for professional design 

purposes. The terms of this license agreement are binding in perpetuity. 
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2. DISCLAIMER.  We intend that the information contained in the SOFTWARE PRODUCT be accurate and reliable, but it 

is entirely the responsibility of the program user to verify the accuracy and applicability of any results obtained from the 

SOFTWARE PRODUCT. The SOFTWARE PRODUCT is intended for use by professional engineers and architects who 

possess an understanding of structural mechanics. In no event will RISA Technologies, LLC or its officers be liable to 

anyone for any damages, including any lost profits, lost savings or lost data. In no event will RISA Technologies, LLC or its 

officers be liable for incidental, special, punitive or consequential damages or professional malpractice arising out of or in 

connection with the usage of the SOFTWARE PRODUCT, even if RISA Technologies, LLC or its officers have been 

advised of or should be aware of the possibility of such damages. RISA TECHNOLOGIES' entire liability shall be limited to 

the purchase price of the SOFTWARE PRODUCT. 

3. LIMITED WARRANTY.  RISA Technologies, LLC warrants that the SOFTWARE PRODUCT will operate but does not 

warrant that the SOFTWARE PRODUCT will operate error free or without interruption. RISA Technologies sole obligation 

and your exclusive remedy under this warranty will be to receive software support from RISA Technologies via telephone, 

email or fax. RISA Technologies shall only be obligated to provide support for the most recent version of the SOFTWARE 

PRODUCT. If your version of the SOFTWARE PRODUCT is not the most recent version RISA Technologies shall have no 

obligation to provide support in any form. Except as stated above the SOFTWARE PRODUCT is provided without warranty, 

express or implied, including without limitation the implied warranties of merchantability and fitness for a particular purpose.  

4. PROTECTION DEVICE.   In the event the SOFTWARE PRODUCT requires the use of a PROTECTION DEVICE to 

operate, you are specifically prohibited from attempting to bypass the functionality of the PROTECTION DEVICE by any 

means. If the PROTECTION DEVICE becomes broken or inoperable it should be returned to RISA TECHNOLOGIES for a 

replacement. The replacement will not be provided if RISA TECHNOLOGIES can not affirm that the broken PROTECTION 

DEVICE was originally provided by RISA TECHNOLOGIES for use with the SOFTWARE PRODUCT. A lost or stolen 

PROTECTION DEVICE will not be replaced by RISA TECHNOLOGIES. 

5. TERMINATION.  RISA TECHNOLOGIES may terminate your right to use the SOFTWARE PRODUCT if you fail to 

comply with the terms and conditions of this agreement. In such event you must delete any installations and destroy any 

copies of the SOFTWARE PRODUCT and promptly return the SOFTWARE PRODUCT to RISA Technologies. 

6. CHOICE OF LAW.   By entering into this Agreement in accordance with Paragraph 1, above, you have agreed to the 

exclusive jurisdiction of the State and Federal courts of the State of California, USA for resolution of any dispute you have 

relating to the SOFTWARE PRODUCT or related goods and services provided by RISA Technologies. All disputes therefore 

shall be resolved in accordance with the laws of the State of California, USA and all parties to this Agreement expressly 

agree to exclusive jurisdiction within the State of California, USA. No choice of law rules of any jurisdiction apply. 

"RISA" as applied to structural engineering software is a trademark of RISA Technologies. 

Maintenance 

Program maintenance provides all upgrades to RISAFoundation , and discounts on new products. 

When your maintenance expires, you will be given the opportunity to continue program maintenance on an annual basis. You 

are under no obligation to continue program maintenance, of course, but if you decide to discontinue maintenance you will 

no longer receive RISAFoundation program upgrades and technical support. 

Complete program support is available to registered owners of RISAFoundation and is included in the purchase price. This 

support is provided for the life of the program. See Technical Support for a list of your support options. 

The ñlife of the programò is defined as the time period for which that version of the program is the current version. In other 

words, whenever a new version of RISAFoundation is released, the life of the previous version is considered to be ended. 

RISA Technologies will support only the current version of RISAFoundation. 

Installation 

To install RISAFoundation  please follow these instructions: 

1. Put the RISAFoundation CD in your computer CD drive. 

2. If the CD starts automatically go to step 4. If the CD does not start after 10 seconds click the Windows Start button 

and select Run. 
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3. In the Run dialog box type ñd:\launchò (where ñdò is the label of your CD drive) and then click the OK  button. 

4. Follow the on-screen instructions. 
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Application Interface  

The User's Guide (a separate document) contains a tutorial that leads you through the RISAFoundation interface with an 

actual model. Consider going through the tutorial if you have not done so already, as it is the fastest way to learn the 

program. Although it requires some time up front, the tutorial will save you time and brainpower in the long run. 

The features that are available to you in RISAFoundation may be accessed through the main menu, shortcut menus, toolbars 

and shortcut keystrokes. You may use any or all of these vehicles to interact with the software. The main menu has the 

advantage of containing all of the program options and features and may initially be the simplest to use, letting you learn just 

one system. The toolbars contain more common options and invoke with one click. The shortcut menus present options 

relevant to the task at hand. The shortcut keys provide a fast way to access features should you use the program often enough 

to make them familiar to you. All of these features are discussed in the sections below. There are many ways to access 

features and the method that you will use will simply be a matter of personal preference. The good news is that you have the 

options. 

The bar along the top of the screen is called the titlebar and contains the name of the file that is currently open. The three 

buttons  on the far right side of the title bar are used to control the main window. The left button will shrink the 

main application window to a button on the taskbar. The middle button will shrink or maximize the window on your screen. 

The right button will close the window, prompting you to save changes if necessary. You will also see these buttons in other 

windows and they have basically the same functions there as well. 

The actual work that you do will be in the main area on the screen, which is called the workspace. When you open a model 

view, a spreadsheet or a dialog it will be opened in the workspace and listed in the Window menu. You may have as many 

windows open as you like. 

Main Menu 

All of the program features may be accessed through the main menu system at the top of the screen beginning with File on 

the far left and ending with Help or possibly Director  on the far right. Clicking on each of these menus (listed below) will 

display sub-menus that contain options that you may choose from. You may also select the main menus by using the ALT 

key along with the underlined letter in the menu you wish to choose. You may then continue to use the keyboard to choose 

from the menu options. In addition, some of the menu options will have hot key combinations listed to the right of the option. 

These hot keys allow you to use the keyboard to access features without using the menu system. 

File Menu 

New will close the current file, prompting for saving if necessary, and will open a new file. 

Open will close the current file, prompting for saving if necessary, and will open an existing file. 

Save will save the current file, prompting for a name if necessary. 

Save As will save the current file, prompting for a name. 

DXF Export  will export the current file to a DXF file. 

For more information on the interaction between RISA and other programs refer to Appendix E.  

Print  will access RISAFoundation printing options. 

Page Setup will present page setup options for printing. 

Recent Files The five most recent files will be listed at the bottom of the menu. Selecting one of these files will close the 

current file, prompting for saving if necessary, and will open the selected file. 

Exit will close RISAFoundation, prompting for saving if necessary. 

../../../Content/Appendices/Appendix%20E.htm
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Edit Menu 

Undo will undo the last edit that was applied to the model whether it was made graphically or in the spreadsheets. You may 

continue to apply Undo to remove up to 100 model edits. 

Redo will reverse the last undo that was applied to the model. You may continue to apply Redo to remove up to 100 undo 

operations. 

Copy will copy the selected spreadsheet cells or model view from the active window to the clipboard. 

Paste will paste data from the clipboard to the spreadsheet cells. 

Insert Line will insert a new line in the spreadsheet beneath the current line. 

Delete Line will delete the current spreadsheet line. 

Repeat Line will insert a new line in the spreadsheet beneath the current line and copy the data from the current line. 

Mark All Lines will select all of the lines in the spreadsheet. 

Unmark Lin es will unmark any currently marked lines. 

Delete Marked Lines will delete the marked lines in the spreadsheet. 

Find will locate an item on the spreadsheet by its label. 

Sort will sort the column containing the active cell. 

Fill Block  will fill the marked block of cells with a valid entry. 

Math on Block allows you to add, subtract, multiply or divide the values in the marked block of cells. 

Global 

Global opens the Global Parameters for the model. 

Units 

Units opens the Units settings. 

View Menu 

New Plan View will open a new model view window. 

Save or Recall Views allows you to save a view or recall a view that has previously been saved. 

Clone View makes a copy of the current view so you can modify one and maintain the other. 

Refresh All will refresh all of the windows that are open in the workspace. 

Select provides graphic select options that are also provided on the Selection Toolbar. 

Unselect provides graphic unselect options that are also provided on the Selection Toolbar. 

Save or Recall Selection States allows you to save a selection or recall a selection that has previously been saved. 

Zoom provides options for zooming in and out of the current model view. 

Rotate provides options to snap the model view to global planes or an isometric view. 

Plot Options opens the Plot Options. 

Render will turn rendering of the current model view on or off, depending on the current setting. 

Drawing Grid  will turn the display of the Drawing Grid on or off, depending on the current setting. 

Project Grid  will turn the display of the Project Grid on or off, depending on the current setting. 

Axes will turn the display of the global axes in the model view on or off, depending on the current setting. 
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Loads will turn the display of the model loads on or off, depending on the current setting. 

Point Labels will turn the display of the point labels on or off, depending on the current setting. A third setting is also 

available where the points themselves are not shown at all. 

Beam Labels will turn the display of the beam labels on or off, depending on the current setting. However, if rendering is 

turned on, beam labels will not be visible in the model view. 

Insert Menu 

The Insert Menu will help you insert new items into the model. Most of the options will provide a graphical method of 

insertion but some will open spreadsheets where appropriate. See Graphic Editing for specific information. 

Modify Menu 

The Modify Menu  will help you modify existing items in the model. Most of the options will provide a graphical method of 

modification but some will open spreadsheets where appropriate. The Delete Items Dialog may also be accessed via this 

menu. See Graphic Editing for specific information. 

Spreadsheets Menu 

The Spreadsheets Menu provides access to any of the input spreadsheets. See Spreadsheet Operations to learn how to work 

within the spreadsheets. 

Solve Menu 

Clicking on the Solve Menu will immediately begin a solution to the model. See Solution for more information. 

Results Menu 

The Results Menu provides access to any of the results spreadsheets. See Results Spreadsheets for more information. 

Tools Menu 

Delete All Unattached Points will delete any points that are not connected to beams, columns, decks, deck edges or loads. 

Preferences contain settings that let you customize the program. See Customizing RISA for more information. 

Customize Toolbar... allows you to modify the model view toolbar by adding, subtracting and re-ordering buttons. See the 

customizable toolbar section. 

Reset All Program Defaults will reset all customized settings to the original factory settings. 

Window Menu 

In order to help you work with the model and the results, you are provided with many window arrangements to choose from. 

You may access them from the Window Menu. The best way to understand just what these 'tilings' do is to try them. 

Remember that once you choose a tiling you may adjust any of the windows as you wish. 

Help Menu 

Help Topics opens the RISAFoundation Help File so that you may search the contents and the index. See Help Options to 

learn about getting help. 

Check for Updates runs an internal check for possible program updates. If your program is up to date, you will receive a 

message saying you are up to date. If you are out of date, the check will offer you the option to email RISA Technologies for 

upgrade information if you are out of date for a major update. If you are out of date just a minor update, then we will send 

you to our website to upgrade.. This check is also offered during the installation process. 

About provides RISAFoundation version and hardware key information. 
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Director Menu 

 

If you are working from within the RISA Building System (RBS), use this menu to switch between RISAFloor, RISA-3D 

and RISAFoundation. If you are not working within the RISA Building System, the Director Menu will not be shown. 

The directory button is located at the far, far right hand side of the Main Menu Toolbar as shown in the image above. 

Shortcut Menu 

The Shortcut Menu is also referred to as the Right-Click Menu . This is because to access the shortcut menu you simply 

click the RIGHT mouse button where you are working to see options that are relevant to what you are doing. For example if 

you are working in a model view the right click menu will provide options to help you modify the view and edit the model 

graphically. If you are working in a spreadsheet the menu will provide editing tools for that spreadsheet. 

This menu will appear wherever you RIGHT click the mouse. This way you do not need to move away from where you are 

working to select the features you want to use. 

Toolbars 

The Toolbars provide buttons to help you access common commands and popular options in the menu system discussed 

above. There are different toolbars that will appear as you work to build your model and browse your results. If at any time 

you are not sure what a particular button does, simply let your mouse hover over the button and a helpful tip will pop up and 

explain the button. 

RISA Toolbar 

 

The first horizontal toolbar located just below the Main Menu is called the RISA Toolbar. The buttons on this bar facilitate 

file and window access. You may use these buttons to open files and windows and also to analyze the model. 

Window Toolbar 

 

 

The Window Toolbar  is the second horizontal toolbar located below the Main Menu. It gets its name because the buttons 

change as you move from window to window in order to help you with what you are currently doing. When you are working 

in a model view the buttons provide viewing tools, such as Rotate and Zoom, to assist you with that view. There are also 

many other results and information display toggles, including some icons with the drop down arrow next to them. Clicking 

the arrow will show you the different view options for that icon. Clicking the icon itself will bring you back to the default 

view. Note that this model view toolbar is now fully customizable. See below for more information. 

Other model view windows that are open will not be affected so that each may show different information. When you are 

working in a spreadsheet, editing tools are provided that are appropriate to that particular spreadsheet. Note that not all tools 

are available with all spreadsheets. In fact there are many tools that are provided for one spreadsheet only. See Spreadsheet 

Operations for more information. 

Customizable Model View Toolbar 

The model view toolbar is fully customizable. By creating your personalized toolbar, you can quickly access your most 

frequently used buttons. This can be done quickly and easily in just a few steps. 

1. Go to Tools menu and select Customize Toolbar. 
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2. Select one of the toolbars by clicking in the box Available toolbar buttons, and click on Add to place them on the 

current toolbar. 

 

3. Once youôve moved the buttons to the Current Toolbar, you can rearrange them by clicking on Move Up or Move 

Down. 

 

4. Click Close and you will see your selections on the model view toolbar. 

Note: 

¶ You must have a model view as the current view to see this toolbar. 

¶ If you add more buttons than will fit on the toolbar the buttons that are at the end of the "Current toolbar buttons" will 

be cut off. 
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¶ The changes you have made will automatically be saved on a per-user (Windows User) basis, such that next time you 

open the program the toolbar will be arranged per your preferences. 

Selection Toolbar 

The vertical toolbar on the left side of the screen is the Selection Toolbar. This toolbar will only be available when the active 

window is a model view. The buttons on this toolbar help you select and unselect items in the model in order to help you 

build and modify the model or view results. See Graphic Selection for more information. 

 

Drawing Toolbar 

 

Another toolbar that is available is the Drawing Toolbar . Unlike those mentioned above, this toolbar is located in the model 

view windows rather than in the main application window. This way the drawing tools stay close to where you are working. 

This toolbar controls modeling features that help you draw, load, and modify your model graphically. You may have more 

than one view open and a Drawing Toolbar for each view. 

The Drawing Toolbar  may be displayed in any model view window by clicking  on the Window Toolbar  while in the 

model view window. Some of the buttons on the toolbar are for one-time applications such as modifying the drawing grid. 

Other buttons place you in an editing mode, such as Draw Members, that remains active until you cancel it. The current mode 

is indicated by the mouse pointer and by the state of the button. While in an editing mode the button will stay down until you 

click it again or choose another button. See Graphic Editing for more information. 

This brings us to an important point. Some of the toolbar buttons remain down when you press them to indicate that you are 

in a certain mode or that something is either on or off. For example the Box Zoom  button will stay down to indicate that 

you are currently in the zooming mode. The Show Drawing Toolbar  button will remain down when you turn on this 

toolbar for the active window. You may be in more than one mode at the same time as long as they are not mutually 

exclusive. 
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The Data Entry Toolbar is the vertical toolbar on the right side of the application window. It contains buttons that facilitate 

data entry through the spreadsheets. The buttons on this toolbar provide quick access to the spreadsheets that are also listed in 

the Spreadsheets Menu. You may open and close the toolbar by clicking the  button on the RISA Toolbar. 

The Results Toolbar is the vertical toolbar on the right side of the application window that is placed over the Data Entry 

Toolbar after the model has been solved. The buttons on this toolbar provide quick access to the results spreadsheets that are 

also listed in the Results Menu. You may open and close the toolbar by clicking the    button on the RISA Toolbar. 

Dynamic View Controls 

When your current window is a graphical model view, you can use the mouse wheel to dynamically zoom, pan, or rotate the 

graphical image. These functions are only available to users who have a mouse with a wheel button and whose computers are 

running the Windows XP operating system. 

Mouse Action Model View Function 

Rolling the Wheel 

Forward 

Zoom In 

Rolling the Wheel 

Backward 

Zoom Out 

Clicking and holding the 

Wheel Button 

Grab the image and pan in the direction of 

mouse movement 

Click and hold the Wheel 

button while pressing the 

Shift key 

Dynamically rotate the structure in the 

direction of mouse movement 

  

Dynamic Pan: Clicking and holding the mouse wheel button triggers the tool and allows the user to pan or drag the view to 

the limit of scroll bars. 

Dynamic Zoom: This tool uses the wheel button on the mouse. Rotating forward zooms in and rotating backward zooms out. 

Dynamic Rotate: This tool is triggered by clicking and holding the mouse wheel button while holding the Shift key. The 

rotational movement will be based on the how the user drags the mouse cursor over the screen and the projection of global 

axis on the screen. For rotation about X axis, drag the cursor perpendicular to the projection of the global X axis. The same 
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logic applies for Y or Z axis rotations. When rotation is initiated, the system locks for rotation about that axis until the user 

releases the middle mouse button. 

Zoom Previous/Next: Function keys F3 and F4 are associated with Zoom Previous and Zoom Next respectively. The system 

holds a doubly linked list of zoom info. This list has 10 zoom-states in the list. The F3 or F4 keystroke moves the active 

pointer forward or backward on the list. Each window has its own zoom list. 

Dynamic Distance Tool: This tool triggers by pressing the F5 key. The user has to pick up two points on the screen and the 

system gives back the total and partial distance between points on the status bar. 

Shortcut Keys and Hot Keys 

Shortcut Keys and Hot Keys allow you to use the keyboard to quickly access features. The difference between the two is 

simply that the shortcut keys are related to a specific window and will only work in that window while the hot keys will 

perform at most any time. 

General Hot Keys 

Key Combination Function 

F1 Help on the active window 

F5 Activates the Dynamic Distance Tool 

Ctrl-F1 Main Help topics 

Ctrl-F2 Create New view 

F7, Ctrl-F7 Opens solution choices 

Ctrl-C Copy to the clipboard 

Ctrl-V Paste from clipboard 

Ctrl-N Start a new file 

Ctrl-O Open an existing file 

Ctrl-S Save the current file 

Ctrl-P Print 

Ctrl-Z Undo 

Alt - Access the menus by combining the Alt 

key with the underlined letter in the menu 

Shortcut Keys available for Specific Windows 

Key Combination Model View Window Spreadsheet 

Ctrl-D Open last graphic editing 

dialog 

Delete Marked Lines 

Ctrl-G Toggle Drawing Toolbar   

Ctrl-A Select All   

Ctrl-U Unselect all   

Ctrl-F   Block Fill 

Ctrl-M   Block Math 

Ctrl-I Invert Selection   



Application Interface 

General Reference Manual 13 

Ctrl-L Toggle Lock unselected Unmark lines 

Ctrl-Enter   Press cell    button 

F2 Open Plot Options Start/Stop Cell Edit 

F3  Insert line 

F4  Delete Line 

F5 Initiates the "Distance" tool Find 

F8   Repeat Current Line 

F9   Sort 

+ Zoom In   

- Zoom Out   

!"#$ PgUp PgDwn Scrolling Scrolling 

  

Spreadsheet Hot Keys that open spreadsheets 

Key Combination Unsolved model Solved Model 

Ctrl-Alt -C Point Coordinates Corner Forces 

Ctrl-Alt -D Line Loads Joint Displacements 

Ctrl-Alt -G Global Parameters   

Ctrl-Alt -L Load Combinations Plate Forces 

Ctrl-Alt -N  Concrete Reinforcing 

Ctrl-Alt -P Point Loads  

Ctrl-Alt -R Design Rules Reactions 

Status Bar 

 

The Status Bar passes useful information to you as you work. It is divided into four parts located along the very bottom of 

the main application window, just beneath the workspace. 

The left side of the status bar shows a solution flag to indicate the solved state of the model as follows:   

Solution Type Unsolved Solved 

Static   

To the right of the solution flags there are three message boxes. 

The first and largest box lets you know what you are currently doing. If you are in a spreadsheet, this box will contain the 

explanation of the current cell. If you are working in a model view and select a graphic editing option, look to this box for 

information on how to use the feature. 

The second box is used to pass you units of the current spreadsheet cell. 

The third box indicates the coordinates of the mouse when a model view is active. The mouse coordinates that are displayed 

are the coordinates of the grid point or joint that is nearest to the mouse. 
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Windows 

Modeling the structure will take place within model views and spreadsheets, each in their own window that may be moved 

around the workspace and sized as you wish. The ability to have multiple model views and multiple spreadsheets open at one 

time is a powerful feature. The options in the Window Menu are provided to help you manage these windows. 

These windows contain three buttons    in the upper right corner to help you minimize, maximize and close the 

window, respectively. There are also scroll boxes to help you view information that is outside of the window viewing area. 

Click the scroll bar buttons or drag the scroll box to advance the display in one direction or another. 

Model Views 

Model View windows show a graphic view of the model. Open a new view with the    button. 

You may open as many model view windows as you like. This is especially helpful when working in close on large models. 

You might have one overall view and a few views zoomed in and rotated to where you are currently working. You may also 

have different information plotted in multiple views. 

One thing to remember is that the toolbars that are displayed depends upon what window is active. The active window is the 

one with the blue titlebar. For example, if you are looking for the zoom toolbar button and the active window is a spreadsheet 

you need to select a model view first before you can access the zooming tools. 

Spreadsheets 

Spreadsheet windows are made up of rows and columns of data cells. If you wish to add or edit data in a spreadsheet cell 

you click on the cell, making it the active cell, and then edit the cell. This active cell is simply the green cell that moves 

around the spreadsheet as you hit the cursor keys (Ŷ , Ÿ), Page Up, Page Down, Home, End, etc. There is always one and 

only one active cell, which is the cell that has the ñattentionò of the keyboard. 

You may also select blocks of data to work on. You can select a block of data by clicking and holding the mouse button on 

the first cell in the block and then dragging the mouse to the opposite corner of the block and releasing the mouse. 

Dialogs 

A Dialog is a third type of window and is used to access a specific function within the program. Another powerful feature is 

that most of the dialogs may be left open while you edit the model, making it easy to make adjustments as you work. You 

will find that dialogs are very easy to work with. There are Help buttons that will bring you directly to the relevant topic in 

the help file. 

Modes 

 There are three basic program modes (View, Select, and Edit ) and a mode hierarchy to allow you to move between them 

easily. While you are editing the model you may select items to edit. When you are finished selecting you will be returned to 

editing. Likewise, while you are selecting items you can adjust the view and then be returned to selecting. 

Different mouse cursors are used with each mode to make it clear what the current mode is. 

View Mode is the upper level mode that allows you to adjust the view by zooming in and out, rotating and setting plot 

options. This mode supersedes all other modes so that you may do these things at any time, and then be returned to the 

previous mode. This mode does not cancel other modes so that when you are finished adjusting the view you are returned to 

what you were doing. See Graphic Display for more information. 

Select Mode is the middle level mode that allows you to make a graphic selection of joints, members and plates.  This mode 

supersedes the Edit Mode but not the View Mode. This means that you can make a selection while in the middle of editing 

the view and when you are finished you are returned to the editing feature that you were using. It also means that you may 

adjust the view while remaining in the same Select Mode. See Graphic Selection for more information. 
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Edit Mode is the lower level mode that allows you to graphically edit the model. You may make selections and adjust the 

view while in the edit mode such that when you are finished selecting you will be returned to the Edit Mode.  Some Edit 

Mode features have options on how you apply the edit. See Graphic Editing for more information. 

Note 

¶ The default mode is the mode you are in if you are not in any other mode and is indicated by the standard 

 mouse cursor. The default mode is a selection mode where you can select/unselect individual items by clicking 

on them. 

¶ You may use the ESC key or the right mouse button to cancel a mode. 
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Beams  

RISAFoundation uses a Physical Member that is automatically sub-meshed into general-purpose beam elements. Beam data 

may be viewed and edited in two ways: graphically in a model view or in the Beams Spreadsheet. See Beams Spreadsheet 

for descriptions of the beam data. 

Drawing Beams 

To create new beams you can draw them using a Drawing Grid, Project Grid, or drawing "dot to dot" clicking existing 

points. You can set all of the beam properties up front or you can modify these properties after you draw the beam. 

Graphically modifying properties is discussed in the next section. 

 

To Draw Beams 

1. If there is not a model view already open then click  on the RISA Toolbar  to open a new view and click  to 

turn on the Drawing Toolbar  if it is not already displayed. 

2. If you are not drawing between existing points, you will need to create a drawing grid or define points on the Point 

Coordinates Spreadsheet. 

3. Click the  button and set the beam properties. 

4. Click Apply  to start drawing beams by clicking on points or grids with the left mouse button. The coordinates of the 

closest point or grid intersection to your cursor are displayed in the lower right hand corner of the status bar. 

The first click will define the Start Point of the first beam. The second click, and each click thereafter, will define the 

End Point of the first member and also the Start Point of the next beam so that you may continue to draw as if your 

pencil is down. To "pick up" the pencil, click the right mouse button. You may then start drawing somewhere else 

with the left button. 

The new beams will be shown on screen and will be recorded in the Beams Spreadsheet. 

5. To stop drawing altogether click the right mouse button or press the Esc key. 

Note 
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¶ Press CTRL-D to quickly recall the last dialog accessed and make changes. 

¶ You may also specify or edit beams in the Beams Spreadsheet. 

¶ You may undo any mistakes by clicking the Undo  button. 

Modifying Beam Properties 

There are a number of ways to modify beams. You may view and edit the beam data in the Beams Spreadsheet.  You can use 

the Modify Properties tool to graphically modify a possibly large selection of beams.   

The graphical Modify Properties tool discussed here lets you modify the properties of beams that already exist in your 

model. To use this, you will typically specify parameters you want changed, then select the beams that you want to modify. 

You can modify beams one at a time by selecting the Apply by Clicking Individually  option and then click on the beams 

you wish to modify. You may also modify entire selections of beams by selecting the beams in the model view first and then 

use the Apply to All Selected option. See the Graphic Selection topic for more on selecting. 

To Modify Beams 

1. If there is not a model view already open then click  on the RISA Toolbar  to open a new view and click  to 

turn on the Drawing Toolbar  if it is not already displayed. 

2. Click the Draw/Modify Beams  button and select the Modify Properties tab. 

3. Set the parameters for the new beams. Check the Use? box for the items that are to be applied. 

4. You may choose to modify a single beam at a time or an entire selection of beams. 

To modify a few beams, choose Apply Entries by Clicking Items Individually , click Apply , and click on the beams 

with the left mouse button. 

To modify a selection of beams, choose Apply Entries to All Selected Items and click Apply . 

Note 

¶ To modify more beams with different parameters, press CTRL-D to recall the Modify Beams Dialog. 

¶ You may also modify beams in the Beams Spreadsheet. 

¶ To relabel beams first sort the Beams Spreadsheet into the desired order, select the Tools Menu and choose 

Relabel Beams. 

¶ You may undo any mistakes by clicking the Undo  button. 

The parameters shown are the same as those used to define new beams. 



Beams 

18 RISAFoundation v3.0 

 

The Use? check boxes next to the data fields indicate whether the particular parameter will be used or not when the 

modification is applied. If the box next to a field is checked, that parameter will be applied to any selected beams, if the box 

is NOT checked, the parameter will NOT be applied, even if a value is entered in the field. This lets you easily change one or 

two properties on beams without affecting all the rest of the properties. Note that if no value is entered in a field (I.e. the field 

is blank) and the corresponding check box is checked, clicking Apply  will have the effect of clearing the data for these fields. 

Beams Spreadsheet 

The Beams Spreadsheet records the properties for the beam elements and may be accessed by selecting Beams on the 

Spreadsheets Menu. 

 

The following data columns hold the data for the beams: 

Beam Labels 

You may assign a unique Label to any or all of the beams. You can then refer to the beam by its label. Each label has to be 

unique, so if you try to enter the same label more than once you will get an error message. You may relabel beams at any 

time with the Relabel Beams option on the Right Click Menu . 

Beam Start and End Points 

The Start Point and End Point entries define the start and end locations of the beams using point labels. 

Shape 

The Shape entry is used to set the beam size. To enter a shape, type the shape name directly or click the  arrow in the cell 

to access the Set Beam Size Dialog. See Beams - Database for more information. 

../../../Content/Common_Design/Concrete%20-%20Database.htm
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Material 

The Material  column displays the concrete material used for each beam. Available materials may be selected from the drop 

down list which contains all entries in the Materials Spreadsheet. See Material Properties for more information. 

Design Rules 

The Design Rules entry displays the selected design rule for each beam. Available design rules may be selected from the 

drop down list which contains all entries in the Design Rules Spreadsheet. See Design Optimization for more information. 

Flexural Layout 

The Flexural Layout  entry displays the selected custom rebar layout for beam flexural reinforcement. Available layouts may 

be selected from the drop down list which contains all Bending Rebar Layouts from the Rebar Layout Database. Select 

Default from the drop down list if you would like RISA to select the reinforcement in the beam. See Rebar Layout Database 

for more information. 

Shear Layout 

The Shear Layout entry displays the selected custom rebar layout for beam shear reinforcement. Available layouts may be 

selected from the drop down list which contains all Shear Rebar Layouts from the Rebar Layout Database. Select Default 

from the drop down list if you would like RISA to select the reinforcement in the beam. See Rebar Layout Database for more 

information. 

Physical Members 

Physical Members provide fixity to all joints that occur along the length of the member, without breaking that member into 

multiple smaller members. You may use the physical member feature to avoid defining one 'field' member with multiple 

members in your model. This saves time in building and editing your model and in understanding your results. 

Continuous beams are examples of continuous 'field' members that can be modeled with one Physical Member. You may 

define them from start to finish without having to explicitly define their connection to other elements or boundaries through 

intermediate points. Subsequently, when it comes time to make changes to a beam you can edit the properties of one Physical 

Member rather than the multiple beams that might otherwise represent it. 

Physical Members are also effective in managing results because the results for one Physical Member are reported together in 

the results spreadsheets and the beam detail report. 

Note 

¶ You cannot convert multiple beams into one Physical Member. To achieve this you must delete the multiple 

beams and define a new Physical Member. 

../../../Content/Common_Design/Concrete%20-%20Database.htm#Rebar_Layout
../../../Content/Common_Design/Concrete%20-%20Database.htm#Rebar_Layout
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Customizing RISA Foundation  

You may customize many of the default parameters, design and analysis options in RISAFoundation. In this way you can 

modify the program so that it best suits you and your work processes. All customization may be defined or redefined at any 

time. The Preferences option on the Tools Menu provides you control over the behavior of the software. The Save as 

Defaults feature allows you to specify the default settings for new model files. These features are discussed below. Custom 

reports may also be defined and saved for future use. See Printing to learn how to build a custom report. 

Save as Defaults 

You may use the Save as Defaults feature in the following dialog boxes by entering the default information in the dialog and 

clicking the Save as Defaults button: Global Parameters, Units, and Drawing Grids . This will cause the program to use 

these settings with any new files that are then created. 

Many of the spreadsheets also provide the option to save the current data as the default and every subsequent new file will 

already have that data. Simply enter the data you want then save it as the default by clicking on the    button. This way the 

office standards that you might use in most of your models are already entered and available in new models. This feature is 

available in the following spreadsheets: Materials, Custom Wood Species, Design Rules, Footing Definitions, and Load 

Combinations. 

Once you create a new file you may redefine any of the default data and settings for that particular file so the Save as 

Defaults feature may be used to give you a good starting point for new files but wonôt hold you to those settings. 

Preferences 

Program options may be accessed by selecting Preferences from the Tools Menu and are divided into the five sections 

described below. Many of the preferences themselves are self-explanatory. 

General Preferences 

The general preferences are straightforward. For help on an item click  and then click that item. It may be a good idea to 

disable the Automatically refreshé option when working with large files or slower computers. You may also set the 

backup timing. See Automatic Backup to learn about the backup capabilities of RISAFoundation. The Reset Customization 

Options button will clear all of the preferences that you have set on any of the tabs. 
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Show "Starting a Model" Panel when starting a new model ï The New Model Dialog will be displayed when opening the 

program or selecting 'New File' from the File Menu. 

Show Global dialog after loading a file ï Displays the Global Parameters settings automatically after loading a file. 

Play the starting sound when starting up the program ï A startup sound will be played when the program opens. 

Play the error sound when showing error messages ï An error sound will be played when an error is displayed. 

Automatically refresh any open windows for any data change ï Changes to the model will automatically be reflected in 

all windows ï spreadsheets and model views. For large models you may want to limit the number of open windows or disable 

this feature altogether. 

Show Toolbars ï All toolbar commands may also be found in the menu system so if you want more work space you may 

disable the toolbars. 

Show Exclude Results confirmation message ï After solving the model you may use the Exclude Feature to graphically 

select items that you wish to see in the results spreadsheets, "excluding" other results. This enables a confirmation message 

warning you that some results are not shown. 

Automatic backup timing ï Automatic backup occurs at the specified interval. No backup occurs if the interval is set to 

zero. 

Reset Customization Options ï Choose this to return to the program defaults. 

Default Region - Choose the default region for your projects. 

Data Entry Preferences 

To use bigger or smaller fonts in the spreadsheets you may adjust the row heights. You may also specify the number of 

decimal places that are displayed. The one exception is the Joint Coordinates. RISAFoundation maintains the coordinates to 

15 significant figures and the exact value is always displayed. You may use the Tools Menu to round off joint coordinates. 

If you wish to use a prefix with your point, beam, and plate labels, such as ñPò with points, you can specify the default prefix. 

These prefixes may be changed as you build your model. 

 

Row height for data spreadsheets ï Sets the row height and font size for data spreadsheets. 

Decimal places for data entry fields ï Sets the number of decimal places to display in the data spreadsheets with a 

maximum of four places. 

Default prefix for POINT labels ï Sets the default prefix to be used in point labels. 

Default prefix for BEAM labels  ï Sets the default prefix to be used in beam labels. 
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Default prefix for PLATE labels  ï Sets the default prefix to be used in plate labels. 

Default prefix for SLAB labels - Sets the default prefix to be used in slab labels. 

Default prefix for SOIL REGION labels  - Sets the default prefix to be used in soil region labels. 

Default prefix for AREA LOAD labels  - Sets the default prefix to be used in area load labels. 

Default prefix for DESIGN STRIP labels- Sets the default prefix to be used in design strip labels. 

Default prefix for DESIGN CUT labels - Sets the default prefix to be used in design cut labels. 

Solution and Results Preferences 

RISAFoundation can provide a warning when clearing results. To use bigger or smaller fonts in the results spreadsheets you 

may adjust the row heights. You may also specify the number of decimal places that are displayed. The number of figures 

displayed may not be the actual number. Behind the scenes RISAFoundation maintains numbers to numerous decimal places. 

 

Always warn before clearing results? ï Verifies that results are to be cleared to edit the model. 

Row height for Results Browsers ï Sets the row height and font size for results spreadsheets. 

Decimal Places ï Sets the number of decimal places to display in the results spreadsheets with a maximum of four places. 

Rotation Limits  ï Shows 0 for the rotation when smaller than this value. 

Batch Results Display - The results of a batch solution may be grouped by load combination or by item. For example you 

can group results for all members under each particular load combination or you can group results from each combination 

under a particular member. The setting here is merely a preference. Once you have solved a model you can switch back and 

forth using the Results Menu. 

Saving Results ï These options let you control what is done with the results when saving a file. 

Font Preferences 

The font preferences are straightforward. They can be used to adjust the fonts used by the spreadsheets, results browsers, and 

graphics. The font changes will affect both the on-screen displayed data and the printed data. The exceptions to this are the 

spreadsheet and browser fonts which may be changed for on-screen display but are hard-wired for printing purposes.   
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If the font data has be set to some unusual settings, then the user can click the Reset All Fonts to Program Defaults button 

to restore the fonts to what is normally expected for the RISA program. 

Printing Preferences 

The printing preferences are straightforward. For help on an item click  and then click that item. See Printing for more 

information. 

 

Preferred orientation for graphics ï Sets the default paper orientation for graphic printing. 

Margins ï Sets the default printing margins. 

Report Preferences ï Sets color or black and white options and header options. 
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File Preferences 

The locations for data files, databases, temporary space, importing, and backing up may be specified separately by choosing 

from the list. 

 

Path and current setting ï For each file type in the list the current setting is displayed. Click the drop down list to view 

different file types. Click the browse button to choose a different location. 
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Design Optimization  

RISAFoundation will optimize Concrete beams and slab reinforcement. The criteria used for this optimization are the 

selected design code and the Design Rules assigned to the beam or slab design strip/cut.   

The Design Rules Spreadsheet records the parameters for the optimization. Optimization is performed for minimum weight, 

taking into consideration any depth, width, rebar limitations, wall dimensions, stud spacing, etc. Note that the design rules 

input is one large spreadsheet, thus all of your design rules will be in the same place. Masonry wall rules could be on one line 

with beam reinforcement on the next. Note that the dimensional rules, the reinforcement rules and the wall rules are all a 

separate entity. They have no interaction with each other in the program. They are simply all input into the same location. For 

example, your masonry wall reinforcement rules will not be influenced by concrete beam reinforcement rules (masonry 

reinforcement rules are specified in the Wall Panel Editor). 

You can assign the design rules graphically as you draw beams and design strips or later as a modification. Design rules for 

slab design cuts may only be applied via the Design Cuts Spreadsheet. See Modifying Beam Properties, Slabs - Design 

Strips, and Slabs - Design Cuts for more information. 

Design Rules - General 

 

You must assign a unique Label to the design rules. You then refer to the design rule by its label when assigning it to slabs or 

beams. The Label column is displayed on all tabs of the spreadsheet. 

Max Bending and Shear Check  

Enter the maximum bending and shear unity checks in the Max Bending Chk and Max Shear Chk columns of the 

spreadsheet. This should usually be specified as '1'. If you desire a larger factor of safety, provide a lower factor (i.e. '0.95'). 

Rebar Yield Strength 

Specify the yield strength of your flexural reinforcement in the Flex Steel column. The units are listed in the column header. 

Concrete Cover 

The last two columns, Top Cover and Bottom Cover, are used to specify the clear cover measured to the slab or beam 

flexural reinforcing steel. The units are listed in the column headers. Note that Side Cover will be entered on the subsequent 

tabs of the spreadsheet. 

Design Rules - Beam Rebar 
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Flexural Bars 

Use the Min Flex Bar  and Max Flex Bar columns to restrict bar sizes for your beam flexural reinforcing. Currently we 

support the ASTM A615 (imperial) and ASTM A615M ("hard" metric, i.e. #8M is an 8mm bar) reinforcement 

standards. You may specify your rebar set in the Global Parameters - Design. You can force the program to analyze one bar 

size by setting the Min and Max values to be the same bar size. 

Shear Ties 

Use the Shear Bar column to enter the size of your shear ties.  Currently we support the ASTM A615 (imperial) and ASTM 

A615M ("hard" metric, i.e. #8M is an 8mm bar) reinforcement standards. You may specify your rebar set in the Global 

Parameters - Design. 

Specify the yield strength of your shear reinforcement in the Shear Steel column. The units are listed in the column header. 

Use the Legs per Stirrup column to enter the specific information about how may legs each of your shear ties is expected to 

have. 

Side Cover 

The last column, Side Cover, is used to specify the clear cover measured to the shear reinforcing. The units are listed in the 

column header. 

Design Rules - Slab Rebar 

 

Rebar Sizes 

The Top Bar and Bottom Bar columns register the flexural reinforcement bar sizes that are to be used in the footing design. 

Currently we support the ASTM A615 (imperial), ASTM A615M ("hard" metric, i.e. #8M is an 8mm bar) and CSA G30.18 

(canadian) reinforcement standards. You may specify your rebar set in the Global Parameters - Design. 

Rebar Spacing 

The Max Top Bar Spacing, Min Top Bar Spacing, Max Bot Bar Spacing, and Min Bot Bar Spacing columns are used to 

set the maximum and minimum bar spacing for the top and bottom slab flexural reinforcement. The units are listed in the 

column headers. 

The Spacing Increment column sets the rebar spacing increment that will be used by RISAFoundation when analyzing 

various rebar layouts between the maximum and minimum bar spacing set in the previous columns. The units are listed in the 

column header. 

Side Cover  

The Side Cover column is used to specify the clear cover from the edge of a design strip or cut measured to the nearest slab 

flexural bar. The units are listed in the column header. Note that this entry should probably be '0' for design strips or cuts that 

do not extend to the edges of a slab provided that they are not directly adjacent to another design strip or cut with a side cover 

greater than '0'. 
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Slab Rebar at Mid-Depth? 

The last column allows the user to place their slab reinforcement at the mid-depth of the slab. 

Design Rules - Footing/Pile Cap Rebar 

 

Rebar Sizes 

The Top Bar and Bottom Bar columns register the flexural reinforcement bar sizes that are to be used in the footing design. 

Currently we support the ASTM A615 (imperial), ASTM A615M ("hard" metric, i.e. #8M is an 8mm bar) and CSA G30.18 

(canadian) reinforcement standards. You may specify your rebar set in the Global Parameters - Design. 

Design Rules - Pedestal Rebar 

 

Rebar Sizes 

The Top Bar and Bottom Bar columns register the flexural reinforcement bar sizes that are to be used in the footing design. 

Currently we support the ASTM A615 (imperial), ASTM A615M ("hard" metric, i.e. #8M is an 8mm bar) and CSA G30.18 

(canadian) reinforcement standards. You may specify your rebar set in the Global Parameters - Design. 

Pedestal Bar Cover 

The last column, Pedestal Bar Cover, is used to specify the clear cover measured to the shear reinforcing. The units are 

listed in the column header. 
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DXF Files  

RISAFoundation provides the ability to export a drawing of your foundation plan (with footing and beam schedules), Footing 

Details or Slab Reinforcing to a DXF file.  

Exporting Foundation Plan Drawings 

Only the joint, member, and element geometry will be translated and used to create an ASCII DXF file.  Any other 

information such as the boundary conditions, loads, member end releases, etc. will not be translated at this time.  You have 

several options available for controlling how DXF files are exported as follows: 

 

DXF Units 

Select the units you desire the CAD model to be created in.  The options for the DXF units are none, inches, feet, mm, cm, 

and meters. 

CAD Scale 

Enter the scale factor that will cause the full scale RISA model to be scaled up or down to the desired drawing scale.  For 

example, if you created a full scale model that you wanted scaled down to 1/4"=12", the factor would be 0.020833, which is 

(.25/12). 
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Standoff Distance  

Enter the distance you wish to have the line entities ñstand offò from the joints to which they are attached.  The standoff 

distance is measured along the axis of the line.  The distance will be in the DXF units, which is defined below.  The distance 

will be used as entered and will not be scaled by the CAD Scale factor. 

Note that if you create a DXF file with a non-zero standoff distance, it will be difficult to use the file for model geometry if 

you read the file back into RISA.  (If you read such a file back in, you will end up with multiple joints at each member 

endpoint which will separated by the standoff distance) 

Grid Bubbles  

You can export the project grid bubbles either as Circles or Hexagons. 

DXF Layer Options  

These controls allow you to customize the layers in the DXF output of your Foundation Plan Drawing. 

The program will add a prefix to each section set layer to designate what type of material that section is.  The prefixes are as 

follows: 

  

For example, letôs say you have designed a structure with Hot Rolled steel section sets called "Column"and " Girder", as well 

as a Wood section set called "Joist". If you type in a member layer name such as "STEEL" then all members, regardless of 

size, will appear on a layer named "STEEL".  However, if you choose ñYesò for the translate section sets to layers option, 

then all the member that are assigned to the Column section set will appear on a layer named "HR_Column", the girders on a 

layer named "HR_Girder", and the joists on a layer called "WD_Joist". 

Exporting Footing Details  

The program can export a sketch of each designed footing. The sketch will show a reinforcement plan, an elevation view and 

a Pedestal Reinforcement plan.  

Exporting Slab Reinforcing Details  

The program can export a schedule of the horizontal and vertical slab reinforcing details. 

DXF Element Numbers 

Different CAD packages handle ordering of geometric data in their DXF files in two basic ways. 

Method 1: 

Entities are written out into the DXF file based on the order in which they were created within the CAD program itself 

regardless of the order in which they were selected at the time the DXF file was made.  Different operations such as copying, 

mirroring, arraying, etc. can produce unexpected results and it therefore becomes necessary to consult your CAD program 

documentation to understand how it stores and orders the geometry that you create via these various operations. 

Method 2: 

Entities are written out into the DXF file based on the order in which they were selected at the time the DXF file was made.  

AutoCAD is such a program.  In order to control the ordering of the LINE entities, you must select the "Entities" option 

under the DXFOUT command and then select the lines in the order that you want them to appear in the RISA model. 

Note 
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¶ Another option to help improve the ordering of the joints, members and elements in a model obtained from 

reading in a DXF file is to sort and relabel them once in RISA. 

DXF File Format 

The specific DXF file that you may read and write is the ASCII Drawing eXchange Files (DXF) file.  Please note that 

AutoCAD has several different forms of DXF files available.  ASCII is the default form and is the only form currently 

supported.  The DXF read/write feature was written based on the DXF documentation for AutoCAD release 14.  The feature 

has been tested with AutoCAD Versions 13 and 14. 

The following is a short excerpt of the AutoCAD ASCII DXF format.  This information is provided to help you debug any 

problems you may be having with DXF files that you are trying to read.  For more complete information, consult your CAD 

documentation. 

General 

A DXF file is composed of sections of data.  Each section of data is composed of records.  Each record is stored on itôs own 

line.  Each particular item is stored as two records, the first record is a group code and the second record is the data or a 

keyword.  RISA only reads the ENTITIES section. 

Group Codes 

Each 2 record item start with an integer group code.  RISA recognizes the following group codes: 

Group Code Description 

0 Identifies the following overall 

keywords: SECTION, ENDSEC, and 

EOF.  Within the ENTITIES section it 

also identifies POINT, LINE, and 

3DFACE. 

2 Identifies a section name (I.e., 

ENTITIES) 

8 Identifies a layer name. 

10, 11, 12, 13 Identifies the X coordinate of the 1st, 

2nd, 3rd and 4th points of an item. 

20, 21, 22, 23 Identifies the Y coordinate of the 1st, 

2nd, 3rd and 4th points of an item. 

30, 31, 32, 33 Identifies the Z coordinate of the 1st, 

2nd, 3rd and 4th points of an item. 

First and Last Records for a DXF file 

Each DXF file must start with the first record as the group code ñ0ò.  The 2nd record must be the keyword ñSECTIONò. 

 Each DXF file must have the 2nd to last record as the group code ñ0".  The last record must be the keyword  ñEOFò. 

Entities Section 

The ENTITIES section will be identified by a group code of ñ0ò, followed in the next record by the keyword ñSECTIONò.  

The next record will be the group code 2, followed in the next record by the keyword ñENTITIESò. 
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Item Formats within the ENTITIES Section 

The POINT format is started by a group code of ñ0ò followed by the keyword ñPOINTò.  The layer name for the POINT will 

start with a group code record of 8, followed by a record with the actual layer name. 

The coordinates for the point will be started by the 10, 20, and 30 group codes respectively for the X, Y, and Z coordinates.  

Other group codes and data may be present within the POINT data but these will be ignored. 

The LINE format is started by a group code of ñ0ò followed by the keyword ñLINEò.  The layer name for the LINE will start 

with a group code record of 8, followed by a record with the actual layer name. 

The coordinates for the first point will be started by the 10, 20, and 30 group codes respectively for the X, Y, and Z 

coordinates. The coordinates for the second point will be started by the 11, 21, and 31 group codes respectively for the X, Y, 

and Z coordinates.  Other group codes and data may be present within the LINE data but these will be ignored by RISA-. 

The 3DFACE format is started by a group code of ñ0ò followed by the keyword ñ3DFACEò.  The layer name for the 

3DFACE will start with a group code record of 8, followed by a record with the actual layer name. 

The X, Y, and Z coordinates for the 1st through 4th points will be started by the 10, 20, and 30 through 14, 24, and 34 group 

codes respectively.  Other group codes and data may be present within the 3DFACE data but these will be ignored. 

  

AutoCAD Layer Names 

The only valid characters in an AutoCAD layer name are the letters A to Z, the numbers 0 to 9, and the three following 

characters: the dollar sign ñ$ò, the underscore ñ_ò, and the dash ñ-ò. 



File Operations 

32 RISAFoundation v3.0 

File Operations  

You may create, save, and recall files from the File Menu or from the toolbar buttons just beneath the menu on the RISA 

Toolbar. Importing and exporting other file types may also be accomplished from the File Menu. 

Starting Off 

When you open the program or start a new model you are presented with the following options: Draw Beams, Draw Slabs, 

and Go to the File Open Dialog 

The first group of options is to help you to create a new model by drawing members or plates or by generating with a 

template drawing beams or slabs. The second group of options helps you open existing files by showing you the most recent 

files or letting you find the model you want in the Open File Dialog. 

Creating a New Model 

¶ On the RISA toolbar click the New Model  button. You will be prompted to 'Save' if you have made changes 

to the current model that have not yet been saved. 

Opening an Existing Model 

1. On the RISA toolbar click the Open File  button. 

2. In the Look In  field click the drive, folder, or location that contains the file. 

3. In the folder list, double-click the folders until you open the folder that contains the file you want. 

4. Double-click the file you want to open. 

Tip 

¶ To open a model you have used recently, click the File Menu and select from the file names at the bottom of the 

menu. 

Saving a New Untitled Model 

1. On the RISA toolbar click the Save Model  button. 

2. To save the model in a different folder, click a different drive in the Save in field, or double-click a different folder in 

the folder list. To save the model in a new folder click the Create New Folder  button. 

3. In the File name field type a name for the document. You can use long, descriptive filenames if you want. 

4. Click Save. 

Saving an Existing Model 

1. On the RISA toolbar click the Save Model  button. 

Automatic Backup 

RISAFoundation provides an automatic backup system for systematically backing up your model data. The purpose of this 

save file is to provide a means for you to recover your data in the event RISAFoundation terminates abnormally. As you 

work within RISAFoundation data is stored in a file called "__FNDAUTO.TMP". When you exit the program normally, this 

file is renamed to ñ__FNDAUTO.BAKò. 

By default, this automatic save operation takes place every 15 minutes, but you can alter the timing and location with the 

Preferences option on the Tools Menu. 
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If RISAFoundation does terminate abnormally, the next time you start the program this message will appear: 

 

If this message appears and you answer "Yes", the data from the last backup of the previous session will be reloaded. If you 

answer "No", the backup data will be deleted and a new backup file will be started. 










































































































































































































































































































